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Overview 
The following document describes the major changes and bug fixes in the Celigo v3.1 software version.  

The software version 3.1 (v3.1.0.22) is a replacement for the prior v 3.0.3 software release (v3.0.3.2) 

The Automation API has been changed over prior releases, but maintains backwards compatibility with 

the existing automation drivers. 
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Changes 

Data Management 

 

The Data Management screen was reworked to provide users with improved search and filter 

capabilities while also providing increased performance when working with large databases. The 

improvements provide data status, usage reporting, and enables users to better manage data and space 

usage. 

The new Data Management is broken into three separate views: Data, Settings, and Summary.  To 

switch between views the user clicks on the tabs at the top of the screen. 
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Data Tab 

 

The Data Tab displays all the data currently stored in the Celigo database.  Data contains all Plates, 

Scans, and Scan Results.  Data is displayed in a grid utilizing a tree like structure to display the relation 

between plates, scans, and scan results. 

Filters 

The default setting for this view is to display all the data the user has access to.  If the user would like to 

limit what is displayed, the user can modify the filter settings found on the left side of the screen. 
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Filters are broken up into 5 sections:  Search, Folders, Plate, Scan, and Result.   

Search 

The “Search” section appears just above the “Folders” section.  This section is primarily an open text 

field that allows the user to type in any text to match a plate barcode, descriptions for any data (plates, 

scans or scan results), or tags for any data (plates, scans, or scan results).  If desired, a checkbox exists to 

limit the filter to only data related tags. 

Folders 

The “Folders” section appears underneath the “Search” section and displays all folders the logged in 

user has access to.  This section allows the user to add, modify, or delete folders as well as selecting 
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which folders to display data for.  If a folder is checked, the data contained within the folder is displayed.  

If a folder is not checked, the data contained within the folder is not displayed.  The Check All and 

Uncheck All buttons exist to quickly perform batch checking/unchecking.  If a user wishes to display a 

single folder, the user double clicks on any folder to check that folder and uncheck all others. 

 

Controls for creating, modifying, and deleting folders exist in the “Folders” section.  This functionality 

works in the same manner as in prior versions of Celigo.  Additional details can be found in section 6 of 

the Celigo Administrator Guide. 

 

Plate Filters 

The “Plate Filters” section appears just below the “Folders” section.  This section allows a user to filter 

plates by plate type (also referred to as the plate profile), plate creator, and whether or not the plate 

has any associated scans. 

Scan Filters 

The “Scan Filters” section appears just below the “Plate Filters” section.  This section allows a user to 

filter scans by the number of channels used when the scan was acquired, image format of the images in 

the scan, time frame the scans were acquired, plate creator, and whether or not the scan has any 

associated scan results. 

Result Filters 

The “Result Filters” section appears just below the “Scan Filters” section.  This section allows a user to 

filter scan results by the scan’s application type, time frame the scan results were generated, and scan 

result creator. 

Other Controls 

If a user modifies any setting while the Auto Refresh checkbox is checked, a refresh operation will occur 

and the software will display the updated data set matching the new filter criteria on the right hand side 

of the screen. 

 

If the Auto Refresh checkbox is not checked, no refresh operation will occur until the user clicks the 

refresh button located at the bottom right hand side of the screen. 
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The Reset Filters button provides the user the ability to revert all the filters back to default settings 

which will display all data on the right hand side of the screen after a refresh is invoked. 

 

The Plate, Scan, and Result Filters are set to have their selectable options and bounds configured for the 

entire dataset available in the database.  What this means is that “Plate Types” will only display plate 

types that are associated with the data in the database.  The same goes for the “Created By” filter and 

all other filters.  For software that is connected to a network database where it is possible for other 

users to be changing the data in the database you are connected to, the bounds of your filters can 

change after your filters have been loaded.  The Refresh Filters button allows a user to refresh the 

bounds of all their filters to the current state of the database.  This button will only be visible for 

software that is connected to a Celigo network database and will be found to the right of the Reset 

Filters button. 

 

Data Display 

Data is displayed in a grid on the right hand side of the screen. The grid utilizes a tree like structure to 

display the relation between plates, scans, and scan results. This section of the screen allows the user to 

view data that matches the specified filters and enables the user to perform various functions on the 

data. 
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The data displayed in the grid is organized by plate.  Each plate can be expanded to display any scans 

that were acquired for the plate.  Each scan can also be expanded to display any scan results that were 

generated for the scan.  The grid is organized into columns that display various properties of the plates, 

scans, and scan results.  These columns include:  Name, Folder, Number of Channels, Image Format, 

Application, Created By, Description, and Tags.  If the column is applicable to the data type, data will be 

displayed.  For example, every data type will have a name, but only plates will display a folder, only 

scans will display Number of Channels, and only scan results will display Application.  Only those 

columns associated with plate data, with the exception of the Tags column, are sortable. 

The button strip at the bottom of the data display section displays the plate count, scan count, and scan 

result count of the found matching data set.  Each data set is broken up into pages and only one page is 

viewed at a time.  On the right hand side of the bottom strip, controls exist to allow the user to navigate 

to different pages of the data set.  A user can type in a page number to navigate to, click on a button 

with an arrow and a line to navigate to the first or last pages, or click on a button with just an arrow to 

navigate to the previous or next page.  If an operation is not allowed, the buttons will become disabled. 
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Data Operations 

 

Each data item (plate, scan, scan result) can be checked or unchecked.  Checking a data item marks the 

data item to be included for an operation if one is chosen by the user.  Data operations can be found at 

the top left of the data display section.  These operations include: Export, Export and Delete, Move, 

Delete, Add Tag, Remove Tag, and Clear All Tags.  One additional operation that exists in this area of the 

user interface that does not involve checked data items is the Import operation.  

Import 

  

The Import button allows the user to import data into the Celigo database.  Celigo data in file format is 

referred to as archives and archives can be imported back into a Celigo database using this operation.  

This functionality works in the same manner as prior versions of Celigo.  Additional details can be found 

in section 7 of the Celigo Administrator Guide. 

Export 

 

The Export button allows the user to export checked data from the Celigo database into a file format 

referred to as an archive.  This functionality works in the same manner as prior versions of Celigo.  

Additional details can be found in section 7 of the Celigo Administrator Guide. 

The Export and Delete button performs the same task as the export operation, but will also delete the 

checked data that was exported after a successful export operation. 

Move 

 

The Move button allows the user to move checked data from one Celigo folder to another. 

Delete 

 

The Delete button allows the user to delete checked data from the Celigo database. 
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Add Tag 

 

The Add Tag button allows the user to add a tag to checked data.  When first clicking on the Add Tag 

button, a dialog will appear asking the user to type in a new tag.  As the user types a tag, a list will 

appear of tags matching the text typed if any exist.  Once the tag has been entered, the user clicks OK to 

complete the operation and then a tag will appear next to the checked items. 

    

 

Delete Tag 

 

The Delete Tag button allows the user to delete a tag from checked data.  When first clicking on the 

Delete Tag button, a dialog will appear asking the user to type in a tag to remove.  As the user types a 

tag, a list will appear of tags matching the text typed if any exist.  If a tag is typed that is associated with 

the checked data, that tag will be removed when the user clicks OK.  If a tag is typed that is not 

associated with the checked data, the data’s tags will remain unchanged. 

    

Clear All Tags 

 

The Clear All Tags button allows the user to delete all tags from checked data. 

Display Operations 

Additional operations can be found at the top right of the data display section. These operations allow 

the user to perform batch operations and various export operations.  These operations include: Check 

All, Uncheck All, Expand All, Collapse All, Copy As Image, Copy As Text, and Export. 
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Check All 

 

The Check All button allows the user to check all data (in all pages). 

Uncheck All 

 

The Uncheck All button allows the user to uncheck all data (in all pages). 

Collapse All 

 

The Collapse All button allows the user to collapse all data down to plates only (in all pages). 

Expand All 

 

The Expand All button allows the user to expand all data so that all plates, scans, and scans are shown 

(in all pages). 

Copy 

 
The Copy As Image button allows the user to copy the displayed data (as seen on the screen) as an 

image to the clipboard. 

The Copy As Text button allows the user to copy all data (in all pages) as text to the clipboard. 

Export 

 

The Export button allows the user to save a text file of all data (in all pages) to disk. 

Plate Operations 

The user can right click on any plate in the displayed area and additional operations for the plate will 

appear via a context menu.  These operations include: Rename, Modify Description, Check All Scans, and 

Uncheck All Scans. 
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Rename 

 

The Rename button allows the user to rename a plate by displaying the plate name in an editable 

textbox.  If the name is already taken or if the name is invalid, the editing box for the name will appear 

red. 

Modify Description 

 

The Modify Description button allows the user to modify the plate description by displaying the existing 

description in an editable textbox. 

Check All Scans 

The Check All Scans button allows the user to quickly check all scans for the specified plate. 

Uncheck All Scans 

The Uncheck All Scans button allows the user to quickly uncheck all scans for the specified plate. 

Scan Operations 

The user can right click on any scan in the displayed area and additional operations for the scan will 

appear via a context menu.  These operations include:  Load Scan, Modify Description, Delete Images, 

Check All Scan Results, and Uncheck All Scan Results. 
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Load Scan 

The Load Scan button allows the user to load the selected scan with its most recent scan result (if one 

exists) into the application workspace. 

Modify Description 

 

The Modify Description button allows the user to modify the scan description by displaying the existing 

description in an editable textbox. 

Delete Images 

The Delete Images button allows the user to delete all images associated with the scan while keeping 

the scan in the Celigo database.  If the user selects this operation, the user will first be prompted to 

confirm the operation. 

 

Once the user confirms the operation, the scan’s images will be deleted.  Once the images are deleted 

for a scan, the scan will have the text “Deleted” displayed in its Image Format column and will no longer 

be capable of being re-analyzed (read-only).  If the scan is loaded, the user will only have access to the 

Results Tab displaying the well thumbnails and measurements.  Since no images are available for the 

scan, well viewing is disabled for the scan. 

Check All Scan Results 

The Check All Scan Results button allows the user to quickly check all scan results for the specified scan. 

Uncheck All Scan Results 

The Uncheck All Scan Results button allows the user to quickly uncheck all scan results for the specified 

scan. 

Scan Result Operations 

The user can right click on any scan result in the displayed area and additional operations for the scan 

result will appear via a context menu.  These operations include:  Load Scan with this Result, and Modify 

Description. 
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Load Scan with this Result 

The Load Scan with this Result button allows the user to load the scan with the specified scan result into 

the application workspace. 

Modify Description 

 

The Modify Description button allows the user to modify the scan result description by displaying the 

existing description in an editable textbox. 

Settings Tab   
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The Settings Tab displays all the settings, currently stored in the Celigo database, which the logged in 

user has access to.  Settings refer to Experiments, Analysis Settings, and Classification Settings.  Settings 

are displayed to the user in a grid on the right hand side of the screen. 

Filters 

The default setting for this view is to display all settings the user has access to.  If the user would like to 

limit what is displayed, the user can modify the filter settings found on the left side of the screen. 

 

Filters are broken up into 3 sections:  Search, Folders, and Setting Filters.   

 

 

 

Search Section 

Folders Section 

Setting Filters Section 
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Search 

The “Search” section appears just above the “Folders” section.  This section is primarily an open text 

field that allows the user to type in any text to match a name, description, or tag for any setting 

(experiment, analysis settings, or classification settings).  If desired, a checkbox exists to limit the search 

to only the setting’s related tags. 

Folders 

The “Folders” section appears underneath the “Search” section and displays all folders the user has 

access to.  This section works in the same manner as it does in the Data Tab. 

Setting Filters 

The “Setting Filters” section appears just below the “Folders” section.  This section allows a user to filter 

settings by setting type, application, setting creator, date the setting was created, and date the setting 

was last modified. 

Other Controls 

If the user modifies any setting while the Auto Refresh checkbox is checked, a refresh operation will 

occur and the software will display the updated settings data set matching the new filter criteria on the 

right hand side of the screen.   

 

If the Auto Refresh checkbox is not checked, no refresh operation will occur until the user manually 

clicks the refresh button located at the bottom right hand side of the screen. 

 

The Reset Filters button provides the user the ability to revert all filters back to default settings which 

will display all data on the right hand side of the screen after a refresh is invoked. 

 

The Setting Filters are set to have their selectable options and bounds configured for the entire dataset 

available in the database.  What this means is that “Setting Types” will only display setting types that are 

associated with the settings in the database.  The same goes for the “Created By” filter and all other 

filters.  For software that is connected to a network database where it is possible for other users to be 

changing the settings in the database you are connected to, the bounds of your filters can change after 

your filters have been loaded.  The Refresh Filters button allows a user to refresh the bounds of their 

filters for all filters to the current state of the database.  This button will only be visible for software that 

is connected to a Celigo network database and will be found to the right of the Reset Filters button. 
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Settings Display 

Settings are displayed to the user in a grid on the right hand side of the screen. This section of the screen 

allows the user to view settings matching the filters specified and enables the user to perform various 

functions on that data. 

 

The settings displayed in the grid are organized into columns that display various properties of the 

settings.  These columns include:  Check, Type, Name, Folder, Application, Created By, Created Data, 

Last Modified, Description, and Tags.  All columns other than Tags are sortable.  The button strip at the 

bottom of the settings display section displays the setting count of the found matching settings set.   

 

Setting Operations 
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Each setting (experiment, analysis setting, classification setting) can be checked or unchecked.  Checking 

a setting marks the item to be included for an operation if one is chosen by the user.  Setting operations 

can be found at the top left of the settings display section.  These operations include: Export, Export and 

Delete, Move, Delete, Add Tag, Remove Tag, Clear All Tags.  One additional operation that exists in this 

area of the user interface that does not involve checked data items is the Import operation.  

Import 

  

The Import button allows the user to import settings into the Celigo database.  This functionality works 

in the same manner as prior versions of Celigo.  Additional details can be found in section 7 of the Celigo 

Administrator Guide. 

Export 

 

The Export button allows the user to export checked settings from the Celigo database into a file format.  

This functionality works in the same manner as it had in prior versions of Celigo.  Additional details can 

be found in section 7 of the Celigo Administrator Guide. 

The Export and Delete button performs the same task as the export operation, but also will delete the 

checked settings that were exported after the export operation is successful. 

Move 

 

The Move button allows the user to move checked settings from one Celigo folder to another. 

Delete 

 

The Delete button allows the user to delete checked settings from the Celigo database. 

Add Tag 

 

The Add Tag button allows the user to add a tag to checked settings.  When first clicking on the Add Tag 

button, a dialog will appear asking the user to type in a new tag.  As the user types a tag, a list will 
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appear of tags matching the text typed if any exist.  Once the tag has been entered, the user clicks OK to 

complete the operation and then a tag will appear next to the checked items. 

    

 

Delete Tag 

 

The Delete Tag button allows the user to delete a tag from checked settings.  When first clicking on the 

Delete Tag button, a dialog will appear asking the user to type in a tag to remove.  As the user types a 

tag, a list will appear of tags matching the text typed if any exist.  If a tag is typed that is associated with 

the checked settings, the tag will be removed when the user clicks OK.  If a tag is typed that is not 

associated with the checked settings, the setting’s tags will remain unchanged. 

    

Clear All Tags 

 

The Clear All Tags button allows the user to delete all tags from checked settings. 

Display Operations 

Additional operations can be found at the top right of the settings display section that allow the user to 

perform batch operations and various export operations.  These operations include: Check All, Uncheck 

All, Copy As Image, Copy As Text, and Export. 

Check All 

 

The Check All button allows the user to check all settings. 
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Uncheck All 

 

The Uncheck All button allows the user to uncheck all settings. 

Copy 

 
The Copy As Image button allows the user to copy the displayed settings on the current screen as an 

image to the clipboard. 

The Copy As Text button allows the user to copy all current settings as text to the clipboard. 

Export 

 

The Export button allows the user to save a text file of all settings to disk. 

Setting Operations 

The user can perform text modification operations on settings in the displayed area.  These operations 

include renaming a setting and modifying a setting’s description.  Both modifications can occur by 

double clicking the cell in the display grid for the specific setting. 
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Summary Tab 

 

The Summary Tab displays to the user a database summary and other miscellaneous administration 

information for the Celigo database.  The Summary Tab is only displayed to local administrator users and 

is broken up into 4 areas:  Database Summary, Over Time, Folder Breakdown, and Created By 

Breakdown. 
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Database Summary 

 

The Database Summary displays summary information for the database the Celigo software is 

connected to.  The data shown here contains connection information, count information for each data 

and setting item, and storage space information. 
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Over Time 

 

The Over Time section displays up to a year’s worth of various information for the Celigo database.  

Charts for the following can be displayed:  Used Space, Database Available Space, Filestream Available 

Space, Plates, Scans, Scan Results, Experiments, Analysis Settings, and Classification Settings. 
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Folder Breakdown 

 

The Folder Breakdown section displays what portion of the Celigo database resides in each Celigo folder.  

Charts for the following can be displayed:  Size, Plates, Scans, Scan Results, Experiments, Analysis 

Settings, and Classification Settings. 
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Created By Breakdown 

 

The Created By Breakdown section displays what portion of the Celigo database was created by each 

user.  Charts for the following can be displayed:  Size, Plates, Scans, Scan Results, Experiments, Analysis 

Settings, and Classification Settings. 

Application Improvements 
The Confluence application and the Colony Suite of applications were both modified for this software 

release. 

Confluence 

The Confluence application was modified to include an additional measurement for scans being 

analyzed with the application.  This new measurement is “Confluence Total Area (µm²)” and reports the 

total confluence area found for each well. 

Colony Suite 

The Colony Suite of applications was modified to include additional Identification and Pre-Filtering 

settings to be used in analysis.   
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The following are new and modified analysis settings available for Colony applications (from top to 

bottom): 

 Well Mask:  The ability to turn the well mask on/off. 

 Diameter:  The diameter setting unit was converted from pixels to microns. 

 Separate Touching Colonies:  The ability to turn separate touching colonies on or off. 

 Minimum Colony Size:  This setting was renamed from Minimum Cluster Size. The 

measurement unit was converted from pixels to microns. 

 Minimum Colony Aspect Ratio:  The ability to specify the aspect ratio for colonies. 

 Colony Intensity Range:  The ability to specify the colony intensity range for colonies. 

New Exports 
New export options are available in the software. 
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ICE 

A new feature exists to export scan and well data into ICE and compressed ACS imaging cytometry 

formatted data. This allows the data to be used with third party software including, but not limited to, 

DeNovo’s FCS Image and FCS Plus version 5.0 and later. 

When ICE and ACS files are read into third party software, the software has access to all the images, AOI 

masks, and AOI parameters.  

 

The ICE format stores the images, AOI Masks, and statistical data for each well in an open directory 

structure. Each well is stored in a folder labeled by the well name. The file structure and contents are 

tracked with an xml file in the root directory. ICE files have the .ice extension. 
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The ACS file format is a zip file with the .acs extension of the ICE folder plus an additional file named 

TOC1.xml that points to the .ice file.  

 

Exporting is done in one of four places: 

1. Full plate export under Results  -> Export Object-Level Data using the .ice and .acs filter
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2. Single well export under Results Single Well preview -> Export Object Level Data  using the .ice 

and .acs filter

 
3. Batch Analysis export under Object Level Export Options. Select ICE or ACS from the drop down.
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4. Batch Export under Object Level Export Options. Select ICE or ACS from the drop down.

 

 

Tabular Well Level CSV 

A new CSV export option exists to allow users to export data in a tabular format.  The new export option 

is available in the well level export operation that can be found in the Results Tab, Batch Analysis, Batch 

Export, and Automation.  The following is an example of the new data format: 
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Well Deletion 
The user has the ability to delete wells in the Results Tab when viewing a scan.  To delete a well, the 

user must right click on the well they intend to delete, and select “Delete”.  After clicking the button, the 

user will be prompted to confirm the deletion.  After the user confirms the action, the well will be 

deleted and removed from the user interface and the next well will become selected. 
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The user can also choose to delete a well while viewing the full well images.  An option to delete the 

well is available at the top of the screen.  If this option is selected, the user will be prompted to confirm 

the deletion.  After the user confirms the action, the well will be deleted and removed from the user 

interface and the next well will become selected. 

 

In the event that the user deletes the last well for a scan, the scan itself will also be deleted and the 

application workspace will auto select the first scan belonging to the loaded plate.  If no other scans 

exist for the loaded plate, the application workspace will clear and the user will be redirected to the 

start screen of the application. 

Usability Improvements 
A number of usability improvements have been made to the software. 

Gate Scatter Plot Display Options 

On the Gate Tab, the user has the ability to modify the display settings of a scatter plot.  To do so, click 

the “Modifies the plot settings” button and additional options will appear that allow the user to modify 

the plot’s data points’ shape type, shape size, and shape color. 
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Scan Deletion in Results Tab 

The option to delete a scan from the Results Tab is now available. If the scan is deleted, the application 

workspace will auto select the first scan of the loaded plate.  If no other scans exist for the loaded plate, 

the application workspace will clear and the user will be redirected to the application start screen. 

 

Scan / Scan Result Descriptions in Results Tab Selection Dropdowns 

Scan and Scan Result summaries are now displayed in the Scan and Scan Result selection controls.  

These controls are visible at the top of the Results Tab and in the plate navigation control when viewing 

images for a specified well. 

 

Updated Context Menu for Scan Grid in Results Tab 

A context menu has been revised for the scan grid view in the Results Tab.  Users can now right click on 

the well and the new options appear for viewing and deleting a well. 

 

New Date Selection Widget 

A new control is now in the software for date selection.  This control allows easier selections of month, 

day, and year. 

 



   

34 This document contains proprietary and/or confidential information that is property of Nexcelom Bioscience, LLC. 

 

New Design for DataGrid Widget 

A new design for data grids is now in the software allowing better identification of selected rows. 

 

Plate Profile Changes 
The following are plate profiles that have been added, updated, or deleted: 

Plate Profile Name Manufacturer Catalog ID # of 
Wells 

Status 

1-Slide holder (2/3 cover slip) Nexcelom Bioscience 200-1SL-HDLR 1 Updated 

1-Slide holder (square cover slip) Nexcelom Bioscience 200-1SL-HDLR 1 Updated 

4-Slide holder (2/3 cover slip) Nexcelom Bioscience 200-4SL-HDLR 4 Updated 

4-Slide holder (square cover slip) Nexcelom Bioscience 200-4SL-HDLR 4 Updated 

1-Well Nunc™ Omnitray Thermo Scientific 242811 1 New 

96-Well Aurora™ 1153 Plate Brooks Life Science 
Systems 

1153 96 Updated 

96-Well Corning™ 3603 Plate Corning 3603 96 Updated 

96-Well SeaHorse™ XF96 Plate SeaHorse XF96 96 New 

96-Well Nexcelom3D ULA-96U 
Ultra-Low Attachment U-Bottom 
Plate 

Nexcelom Bioscience ULA-96U 96 New 

384-Well BD Falcon™ 353962 
Plate 

Corning 353962 384 New 

384-Well Nexcelom3D ULA-384U 
Ultra-Low Attachment U-Bottom 
Plate 

Nexcelom Bioscience ULA-384U 384 New 

Bug Fixes 
The following section lists each bug that was addressed in this release. 

ID Title 

85 Gating tab with Omnitray error 

93 Results New Well Image Refreshing 
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135 Numeric Minimum Forcing 

136 FCS Exporting 

210 Move plate profile Corning 3603 to Supported list 

211 Move plate profile 384w Corning 3827 to Supported list 

212 Include plate profile 384-well BD Falcon 353962 as 
Supported 

213 Remove Aurora plates from included profiles 

215 Add 96w Seahorse plate profile to imaged list 

216 Change slide holder profiles to Nexcelom instead of 
Brooks Life Science Systems 

222 Installation Fail - Rollback incomplete 

223 Mock/Satellite broken with Upgrade 

267 1-Well Nunc Omnitray TM superscript 

268 warning in event log should be marked as error 

269 Application freezes when clicking on wells quickly 

385 Analysis settings should not be accessible to users that 
do not have access permission 

387 Satellite Restore Progress Value always 0 percent even 
though progress is made or complete 

392 TS Growth Tracking states it's reporting in csv export 
Ave Area, but it really is reporting Estimated volume 

426 Read/Write/Delete user is able to change folder 
permissions 

432 Exporting Multiple Setting Files 

448 Recover Free Space error 

469 Batch Analysis: scan selection at bottom of list jumpy 

470 Batch Analysis: right panel doesn't stay in view of last 
scan selected 

557 DB Migration 3.1.0.0 Hardcoded 'USE CELIGO' 

558 Data Mgmt: Data columns not scrolling 

559 Deleting Tags CAPS Behavior 

562 Renaming Plate with already taken name 

568 Scan Filter - Has Results: No 

572 Has Data/Settings interaction between tabs 

576 Well Deletion Crash 

577 DB Mgmt: Data vertical scroll bar reverting on click 

578 DB Mgmt: Data vertical scroll bar + mouse wheel 

589 Scan Export (archive) not working 

629 HWAF Cal gain not set by default 

630 Application SLOW loading 

634 Auto Refresh w/Reset Filter 

635 New Scatter plot settings causing DNA Synthesis scans 
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to crash in gate tab 

638 Double clicking folders in folders table should 
check/uncheck 

640 Data management: enter should invoke search when 
typing (if auto refresh) 

642 Data filters created between should have text changed 

644 Data results disappear after perform export and delete 
(archive and delete) 

646 Clear all tags should clear children as well 

648 Focus not set on tag dialog 

650 well deletion should select next well 

653 csv export (well level) on results screen should have a 
default name 

655 enable plate profile calibration always 

658 Dialog for importing plates still states restore 

661 Folder operations (new, modify, delete) are not 
reflected in results or other tabs if auto refresh on 

664 Data Mgmt: Column sorting + Folder Deletion 

665 Creating Plate Crash 

666 Settings - Folder Creation Fatal Crash 

667 Data Mgmt: Folder Modification + Auto Refresh SLOW 

668 new data grid style for gating data grids causing 
slowness with large number of aois 

670 Plate ID text wrapping in Data Mgmt 

671 Automatic re-sizing of application column in Data 
Mgmt crashes the Celigo application 

674 Load Existing Scans, Plate IDs only visible in "All 
Folders" 

675 New measurements do not appear in updated 
applications for old scan results in Analyze Tab Preview 
Results until after re-analysis. 

676 v3.1 installers install applications with v3.0.2 

678 Automation Sample app still states ice on ui 

679 Automation export of ice on 96 well caused an assert 

681 load scan with no results should auto select create new 
mode 

682 Restoring Window extremely buggy 

683 Access Empty Database Error 

684 USBIOControlService.exe = Brooks Labeled 

686 Result Screen when a single well is selected and 
displayed, Export Object Level Data Fails for ACS (was 
ICE) 

687 ACS format export failing, due to misbehaving 
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Debug.Assert 

699 Disable Plate Calibration before login 

703 Regression Testing 3.1 Output File Names 

705 Data migration failed for large 3tb network database 

706 data management slow for large data sets 

708 Crash when naming a population ALL 

710 Reports button the results scan grid has incorrect text 
margin 

711 Generate report causes crash if no scans selected 

712 modified scan description is not updated in the 
dropdown summary 

713 Default name for well level export is not valid 

714 No default file name specified for plate level object 
level export 

715 Evaluate Performance of ACS export 

716 Batch: Entering a start date that's past the end date for 
a filter causes a crash 

717 Celigo S upgrade process doesn't have code that allows 
plate calibration wizard 

720 No busy cursor when browsing for archives 

725 long folder names when creating new folders expands 
the size of the new folder dialog 

730 Moving data to another user’s private folder not 
working as expected. 

733 check all/uncheck all keeps action buttons enabled 

734 renaming a plate, enter should complete the task 

735 empty plate name allowed 

736 Implicit filters? 

737 exporting a classification setting always gives an error 

751 Load/Acquisition of 1536 plates one after the other 
results in different geometry layouts 

752 Segmentation missing objects in a single well of a multi 
well acquisition/analysis of 24 well plate. 

759 uncheck/check all folders performs refresh for each 
folder 

769 Very wide plate viewer control when long descriptions 
for scan or scan result are present. 

776 Batch Analysis - Scan Time not displayed 

777 Multi channel (BR + FL +...) exports to .ice not exporting 
correct mask dimensions 

780 double click on folders in data management should be 
exclusive 

785 Incorrect Thumbnail displayed in Result Tab 
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787 Sorting no longer working for data management data 
tab columns 

788 Implement Nexcelom3D plate profiles in 3.1 release 

793 Plate ID Field Cleared if Current Value Matches Saved 
Value 

799 Recover Free Space is creating error message 

800 User Data Not Displayed Until Subsequent Action 

808 Scan Results Created By Breakdown Pie Chart Missing 

824 Results being deleted with migration 

828 Data Summary - Over Time - Scan Result chart empty 

836 Error occurring after well deletion 

 


